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FEATURES 
Full featured evaluation board for the AD7924, AD7914, and 

AD7904 devices 
Evaluation control board (EVAL-CONTROL-BRD2) compatible 
Standalone capability  
On-board analog buffering and voltage reference 
Various linking options 
PC software for control and data analysis when used with the 

EVAL-CONTROL-BRD2 

GENERAL DESCRIPTION 

This data sheet describes the evaluation board used to test the 
AD7924, AD7914, and AD7904 ADCs. Packaged with each 
EVAL-AD7924/AD7914/AD7904 is a sample box containing 
one AD7924, one AD7914, and one AD7904 ADC. Place the 
ADC to be tested in the socket on the evaluation board. 

The AD7924/AD7914/AD7904 ADCs are high speed, 12-bit,  
10-bit, and 8-bit, respectively, successive approximation ADCs. 
These parts operate from a single 2.7 V to 5 V power supply and 
feature throughput rates of up to 1 MSPS.  

Refer to the AD7924/AD7914/AD7904 device data sheet in 
conjunction with this data sheet.  

On-board components for this evaluation board include 

• One AD780, which is a pin-programmable, 2.5 V or 3 V 
ultrahigh precision band gap reference 

• One REF192 2.5 V reference 

• One AD712 op amp 

• One AD713 quad op amp  

Various link options are provided in Table 1. 

This evaluation board has a 96-way connector, that is compatible 
with the evaluation board controller (EVAL-CONTROL-BRD2), 
also available from Analog Devices, Inc.  

External sockets are provided for the REFIN, SCLK, DIN, 
DOUT, and CS signals, two bias-up circuits for bipolar input 
signals, and four sockets (VIN0 to VIN3) for the analog input 
channels. 
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Figure 1. 
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EVALUATION BOARD HARDWARE 
LINK OPTIONS 
There are 20 link options to be set before using the evaluation board. The functions of the options are outlined in Table 1. 

Table 1. Link Functions 
Link No. Function 
LK1 to LK4  Connects the inputs of the AD713 to the input sockets (VIN0 to VIN3) or ties the AD713 inputs to AGND.  

In Position A, the relevant AD713 input is connected to the relevant input socket.  
In Position B, the relevant AD713 input is connected to AGND.  

LK5  Selects the source of the REFIN voltage to be applied to the REFIN pin of the AD7924/AD7914/AD7904 and to the bias up circuits.  
In Position A, the REF192 supplies the +2.5 V reference to the AD7924/AD7914/AD790.  
In Position B, the AD780 supplies the +2.5 V reference to the AD7924/AD7914/AD790. 

LK6  Selects the source of the VDD supply to the AD7924/AD7914/AD7904.  
In Position A, the supply voltage, VDD, is taken from an external source via J5.  
In Position B, the supply voltage is taken from the EVAL-CONTROL-BRD2 via the 96-way connector. 

LK7  Selects the source of the CS signal for the AD7924/AD7914/AD790.  

In Position A, the CS signal is generated by the EVAL-CONTROL-BRD2 via the 96-way connector. 

In Position B, the CS signal is applied from an external source via the CS SMB socket. 

LK8  Connects the data out pin, DOUT, of the AD7924/AD7914/AD790 to the EVAL-CONTROL-BRD2 to an external SMB socket.  
In Position A, the DOUT pin of the AD7924/AD7914/AD790 is connected to the EVAL-CONTROL-BRD2.  
In Position B, the DOUT pin of the AD7924/AD7914/AD790 is connected to the external DOUT SMB socket. 

LK9  This link option selects the source of the data to be applied to the DIN pin of the AD7924/AD7914/AD7904.  
In Position A, the data being applied to the DIN pin of the AD7924/AD7914/AD7904 comes from the EVAL-CONTROL-BRD2.  
In Position B, the data being applied to the DIN pin of the AD7924/AD7914/AD7904 is from an external source applied via 
the DIN SMB socket. 

LK10  Selects the source of the +12 V supply for the EVAL-AD7924/AD7914/AD7904. 
In Position A, the +12 V supply is sourced from the EVAL-CONTROL-BRD2 via the 96-way connector.  
In Position B, the +12 V supply is sourced externally via the J2 connector. 

LK11  Selects the source of the −12 V supply for the EVAL-AD7924/AD7914/AD7904.  
In Position A, the −12 V supply is sourced from the EVAL-CONTROL-BRD2 via the 96-way connector.  
In Position B, the −12 V supply is sourced externally via the J2 connector. 

LK12  Selects the source for the VDRIVE voltage.  
In Position A, VDRIVE is connected to AVDD of the AD7924/AD7914/AD7904.  
In Position B, the VDRIVE is taken from the Evaluation Controller Board via the 96-way connector.  
In Position C, the VDRIVE is taken from an external source via the external J4 connector. 

LK13  Selects the source for the SCLK signal applied to the SCLK pin of the AD7924/AD7914/AD7904.  
In Position A, SCLK is applied from an external source via the SCLK SMB connector. 
In Position B, the SCLK signal is an inverted signal from the EVAL-CONTROL-BRD2.  
In Position C, the SCLK is sourced directly from the EVAL-CONTROL-BRD2. 

LK14  Controls the program pin of the AD780 voltage reference. When inserted, the AD780 output voltage is set to 3.0 V. When 
removed, the AD780 voltage is set to +2.5 V. 

LK15 to 
LK20  

Add a 51 Ω termination resistor to AGND at the VIN0 to VIN3 input sockets. When a 51 Ω termination is required, these links 
should be inserted. 
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OPERATING WITH THE EVAL-CONTROL-BRD2  
The evaluation board can be used either as a standalone board 
or it can be operated in conjunction with the EVAL-CONTROL- 
BRD2. When operated with the EVAL-CONTROL-BRD2, all 
supplies and control signals to operate the AD7924/AD7914/ 
AD7904 are provided by the EVAL-CONTROL-BRD2. 
Software to communicate between the controller board and the 
AD7924/AD7914/AD7904 is provided with the AD79x4 
evaluation board kit. The EVAL-CONTROL-BRD2 operates 
with all Analog Devices evaluation boards with model numbers 
ending in the letters CB. 

POWER SUPPLIES 
When using this evaluation board with the EVAL-CONTROL-
BRD2, all supplies are provided from the controller board 
through a 96-way connector. 

When using the board as a standalone unit, external supplies 
are required. This evaluation board has seven power supply 
inputs: EXT_VDD, AGND, +12 V, −12 V, AGND, VDRIVE, and 

DGND. If the evaluation board is used in standalone mode, a 
2.7 V to 5 V supply must be connected to the EXT_VDD input. 
The +12 V and −12 V supplies are required for the op amps. 
The VDRIVE input connects to a supply from 2.7 V to 5 V 
allowing the evaluation board to be connected to both 3 V and 
5 V systems. The supplies are decoupled to the ground plane 
with 10 μF tantalum and 0.1 μF multilayer ceramic capacitors at 
the entry point to the board. The supply pins of all the op amps, 
reference, and the AD7924/AD7914/AD7904 are decoupled 
with 10 μF tantalum and 0.1 μF ceramic capacitors. 

INITIAL SETUP CONDITIONS 
Care should be taken before applying power or signals to the 
evaluation board to ensure that all link positions are set up per 
the required operating mode. Failure to do so could result in 
damage to the evaluation board.  

Table 2 outlines the default positions of all links when the board 
is shipped. All links are set so that all power supplies and 
control signals are supplied by the EVAL-CONTROL-BRD2.

Table 2. Initial Link Positions 
Link No.  Position  Function  
LK1  A  Input of AD713 is connected to the VIN0 SMB socket.  
LK2 to LK4  B  AD713 inputs are connected to GND.  
LK5  B  The AD780 supplies the 2.5 V reference to the AD7924/AD7914/AD7904.  
LK6  B  VDD is supplied from the EVAL-CONTROL-BRD2.  
LK7  A  CS signal is generated by the EVAL-CONTROL-BRD2.  

LK8  A  DOUT pin is connected to the EVAL-CONTROL-BRD2.  
LK9  A  Data applied to the DIN pin of the AD7924/AD7914/AD7904 is generated by the EVAL-CONTROL-BRD2.  
LK10  A  +12 V supply is generated by the EVAL-CONTROL-BRD2.  
LK11  A  −12 V supply is generated by the EVAL-CONTROL-BRD2.  
LK12  B  VDRIVE is generated by the EVAL-CONTROL-BRD2.  
LK13  C  SCLK signal is sourced directly from the EVAL-CONTROL-BRD2.  
LK14  OUT  AD780 voltage is set to 2.5 V.  
LK15 to LK20  OUT  Inputs not terminated.  

http://www.analog.com/ad7924
http://www.analog.com/ad7914
http://www.analog.com/ad7904
http://www.analog.com/ad7924
http://www.analog.com/ad7914
http://www.analog.com/ad7904
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INTERFACING THE EVALUATION BOARDS 
Interfacing the EVAL-CONTROL-BRD2 to the evaluation 
board is accomplished via a 96-way connector, J1. Plug the  
96-way connector on the evaluation board directly into the 96-
way connector on the EVAL-CONTROL-BRD2.  

The 96-way connector is powered from a 12 V ac transformer. 
Suitable transformers are available from Analog Devices as an 
accessory under the following part numbers: 

• EVAL-110VAC-US (for use in the U.S. or Japan) 

• EVAL-220VAC-UK (for use in the U.K.) 

• EVAL-220VAC-EU (for use in Europe) 

 

 

These transformers are also available from Digi-Key Corp. 
(U.S.) and Campbell Collins, Ltd. (U.K.). 

Connection between the EVAL_CONTROL-BRD2 and the 
parallel port of a PC is accomplished via a standard Centronics, 
Inc. printer port cable, which is provided as part of the 
EVAL_CONTROL-BRD2 kit.  

Figure 2 shows the pinout for the 96-way connector. Table 3 
and Table 4 list the pin designations and descriptions. The 
unused pins of the 96-way connector are not shown. 

A
B
C

1 8 16 24 32

1 8 16 24 32 06
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Figure 2. Pin Configuration for the 96-Way Connector 

Table 3. Pin Descriptions 
Signal Description  
DR0  Data Receive. Serial data from the device is provided at this 

output. Sixteen bits of data are provided with a leading 
zero, three channel address bits, followed by twelve bits of 
conversion data, which is provided MSB first (for the AD7924). 
Refer to the AD7924/AD7914/ AD7904 data sheets. 

DT0  Data Transmit. Serial data from the DSP is provided at this 
pin. Twelve bits of data are provided MSB first. 

SCLK0  Serial Clock Zero. This continuous clock is connected to the 
SCLK pin of the device via LK13 to obtain serial data from 
the ADC. 

TFS0  Transmit Frame Sync Zero. 

RFS0  Receive Frame Sync Zero. Both of these inputs, TRS0 and 
RFS0, are connected to the ADC CS pin to initiate 
conversions and to frame the serial data transfer. 

DGND  Digital Ground. These lines are connected to the digital 
ground plane on the evaluation board. It allows the user to 
provide the digital supply via the connector along with the 
other digital signals. 

AGND  Analog Ground. These lines are connected to the analog 
ground plane on the evaluation board.  

AVDD  Analog +5 V Supply. These lines are connected to the AVDD 
supply line on the evaluation board via LK6.  

+12 V  +12 V Supply. This line is connected to the +12 V supply 
line on the evaluation board via LK10.  

−12 V −12 V Supply. This line is connected to the −12 V supply 
line on the evaluation board via LK11.  

 

Table 4. 96-Way Connector Pin Functions 
Pin No. Row A Row B Row C 
1     
2     
3     
4  DGND  DGND  DGND  
5  DT0   DR0  
6  TFS0   RFS0  
7  SCLK0   SCLK0  
8     
9     
10     
11     
12  DGND  DGND  DGND  
13     
14     
15     
16  DGND  DGND  DGND  
17     
18     
19     
20  DGND  DGND  DGND  
21  AGND  AGND  AGND  
22  AGND  AGND  AGND  
23  AGND  AGND  AGND  
24  AGND  AGND  AGND  
25  AGND  AGND  AGND  
26  AGND  AGND  AGND  
27   AGND   
28   AGND   
29  AGND  AGND  AGND  
30  −12 V AGND  +12 V 
31     
32  AVDD  AVDD AVDD 

 

http://www.analog.com/ad7924
http://www.analog.com/ad7914
http://www.analog.com/ad7904
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SOCKETS 
There are eight input/output sockets relevant to the operation of the AD7924/AD7914/AD7904 on this evaluation board. The functions of 
these sockets are outlined in Table 5. 

Table 5. Socket Functions 
Socket  Function  
J1  The 96-way connector for serial interface and power supply connections. 
J2  External +12 V, −12 V, and AGND power connector.  
J3  External VDRIVE connector.  
J4  Subminiature BNC socket for bipolar input signal to bias up circuit 0.  
J5  External VDD and AGND power connector.  
J6  Subminiature BNC socket for output from bias up Circuit 0. Unipolar signal.  
J7  Subminiature BNC socket for bipolar input signal to bias up Circuit 1.  
J8  Subminiature BNC socket for output from bias up Circuit 1. Unipolar signal.  
VIN0 to VIN3  Subminiature BNC sockets for analog input Channel 0 to Channel 3.  
REFIN  Subminiature BNC socket for REFIN voltage.  
SCLK  Subminiature BNC socket for external SCLK.  
CS Subminiature BNC socket for external CS.  

DIN  Subminiature BNC socket for external DIN.  
DOUT  Subminiature BNC socket for DOUT signal.  

 



 EVAL-AD7924/AD7914/AD7904
 

Rev. 0 | Page 7 of 16 

EVALUATION BOARD SOFTWARE 
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Figure 3. Main Dialog Box 

INSTALLING THE SOFTWARE 
The EVAL-AD79x4 kit includes a CD-ROM.  

When the CD is inserted into the PC, an installation program 
automatically begins. This program installs the evaluation 
software.  

THE MAIN DIALOG BOX 
The software that controls the EVAL-CONTROL-BRD2 and, 
therefore, the AD79x4 evaluation board consists of three dialog 
boxes. The main dialog box, shown in Figure 3, allows you to 
read a predetermined number of samples from the evaluation 
board and display them in both the time and frequency domain. 
This dialog box can be divided into three sections.  

The top section of the dialog box contains the control buttons, 
the menu bar, and the status windows. 

Control Buttons 

Use the control buttons to take samples (Sample), reset the 
board (Reset), and get information about the software.  

Click the Reset button for the EVAL-CONTROL-BRD2 to 
perform a reset. When this happens, the power supply to the 
evaluation board is turned off, and the program in the DSP 
memory is lost. If required, set up the board again to download 
another program. Click the Quit button to exit. Note, however, 
that the program running on the EVAL-CONTROL-BRD2 is 
not terminated.  

Menu Bar  

The menu bar consists of the File, Printer Port, Control 
Register, and Help drop-down menus.  

The File drop-down menu offers the following selections: 

• Setup Menu. Select this option to display the Setup Menu 
as shown in Figure 5. 

• Load Raw Data. Select this option to load data saved by 
the software during a previous session. 

• Save Raw Data. Select this option to save the current set of 
sample data points. The data can be reloaded to the 
evaluation software later or can be used by other programs 
for analysis. 

• Save Binary Data. Select this option to save the current set 
of sample data points. The data is saved in binary format as 
a text file. This method can be useful for examining code 
flicker and looking for stuck bits. 

• Save FFT Data. Select this option to save the current set of 
FFT data points. FFT data cannot be reloaded into the 
EVAL-CONTROL BRD2 software, but can be loaded into 
other software packages for further analysis. 

• Exit. Quits the program. 



EVAL-AD7924/AD7914/AD7904 
 

Rev. 0 | Page 8 of 16 

The Printer Port drop-down menu allows you to select which 
printer port to use for communication with the EVAL-
CONTROL BRD2.  

• LPT1. This option selects 0x378 as the printer port base 
address. This is the default option. 

• LPT2. This option selects 0x278 as the printer port base 
address.  

• PRN. This option selects 0x3BC as the printer port base 
address.  

Set up the operating conditions for the device using the Control 
Register drop-down menu. Once you select conditions, a 12-bit 
word is sent to the AD79x4 control register on the next serial 
transfer. 

The Help drop-down menu provides information about the 
current revision of software for the evaluation board. 

Status Boxes 

These windows boxes display the setup of the evaluation board, 
the number of samples taken, and any messages generated. 

Oscilloscope 

The middle section of the main dialog box is a digital storage 
oscilloscope (DSO). Samples uploaded from the EVAL-
CONTROL-BRD2 are displayed here. Samples can be displayed 
as integer values or as voltages. Once samples are displayed, 
click any point in the graph to display the sample number and 
the value of the point. Along the axis of the graph are zoom 
handles. Zoom in and out to get a closer look at a particular 
sample, if required. When another set of samples is taken, the 
graph attempts to display all values collected unless the Hold 
Zoom check box is selected. The graph retains the same axis 
settings as the previous set of data samples. Additional check 
boxes are provided allowing you to control the vertical and 
horizontal grids, and data points. 

Fast Fourier Transform/Histogram 

The lower section of the screen shows a fast Fourier transform 
(FFT) of the data or a histogram, which shows the number of 
occurrences of each particular code read back. The FFT (default 
option) is typically used if you are concerned with examining an 
ADC’s performance in the frequency domain while the 
histogram indicates the ADC’s performance with DC signals. 
The option displayed can be switched by clicking the FFT 
Mode/Histogram Mode button at the top right of the dialog 
box. Figure 4 shows the main dialog box with the Histogram  
Mode option selected. 
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Figure 4. Main Dialog Box, Histogram Mode
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SETUP MENU 
The Setup Menu, shown in Figure 5, allows you to load the 
required configuration file for the evaluation board. When the 
configuration file is loaded, the software acquires detailed 
information about the evaluation board and the ADC 
connected to the EVAL-CONTROL-BRD2. This includes 
information such as the number of bits, maximum sampling 
rate, output coding, maximum analog input, and power supply 
requirements.  

The configuration file also indicates to the software the name of 
the DSP program file to download to the EVAL-CONTROL-
BRD2. The Setup Menu allows you to choose the sampling 
frequency and the number of samples to take.  

CHECKING THE EVAL-CONTROL-BRD2 
The EVAL-CONTROL-BRD2 and the evaluation board should 
be connected together as described in the Interfacing the 
Evaluation Boards section. 

At this stage, the red LED on the EVAL-CONTROL-BRD2 
should be flashing. This indicates that the EVAL-CONTROL-
BRD2 is functional and ready to receive instructions.  

Note that the software should be installed before the printer 
port cable is connected between the EVAL-CONTROL-BRD2 
and the PC. This ensures that the printer port has been 
initialized correctly.  

USING THE SOFTWARE 
Once the hardware and software is set up: 

1. From the File menu, select Setup.  

A set up form displays. A list box  on the Setup Menu lists 
the available configuration files. The configuration files are 
text-based files containing information about the ADC to 
be tested (AD7924.cfg, AD7914.cfg, and AD7904.cfg).  

2. Select the relevant configuration file and click Load.  

Choose the configuration file depending upon which 
device is in the socket of the evaluation board. The EVAL-
CONTROL-BRD2 is reset and the DSP program is 
downloaded. Once the download is complete, the power 
supply settings indicated in the configuration file are set 
and you may hear some of the relays clicking. The drop-
down list boxes, Select No. Of Samples and Select Sample 
Frequency, are set to the default values specified in the 
configuration file. Note that you can change these settings 
at any point.  

3. Once all the settings are set, click Close to return to the 
main dialog box. 

Default Conditions 

The EVAL-AD7924/AED7914/AD7902 is configured to convert 
on Channel 0, 0 to REFIN input range, normal mode with 
straight binary output coding. If no changes are made to the 
control register via the Control Register drop-down menu on 
the main dialog box, clicking Sample yields conversion results 
from Channel 0. 
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Figure 5. Setup Menu 
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Taking Samples 

To instruct the EVAL-CONTROL BRD2 to take the required 
number of samples at the required frequency, follow these steps 
using the Main Screen shown in Figure 3: 

1. Click Sample. 

Select a sampling frequency up to the rate of 1 MSPS.  

Samples are uploaded and displayed. An FFT and 
histogram are also calculated and displayed.  

2. Click Cont Sample to continue taking samples.  

To stop sampling, click Cont Sample again. Note that 
while the software is continuously sampling data the other 
control buttons are disabled. 

3. Click Exit to stop the process.  

Software Configuration Files 

Software configuration files provide the EVAL-CONTROL-
BRD2 software with information on how the software and 
hardware should perform. These files contain information, such 
as the name of the DSP program to download, the default and 
maximum sampling frequencies, the number of samples to take, 
and the power supply settings to use.  

What follows is a typical Software Configuration File (*.cfg). 

[EVAL-CONTROL BOARD] 
partname:AD7924 
programname:ad7924.PRG 

samplefrequency:100000 
maxsamplefrequency:1000000 
samples:2048 

 

+/−15V:on 
dvdd:5:on 
avdd:5:on 
bus:on 
;options 2scomp, binary 
dataformat:binary 
numberofbits:12 
inputVmax:2.5 
inputVmin:0 
[endofconfig] 

Sequencer Modes: FFT Mode and Histogram Mode 

FFT Mode 
To operate the EVAL-AD7924/AD7914/AD7904 in FFT mode 
with the sequence and shadow bits set to 11 in the Control 
Register, follow these steps: 

1. Select the 11 combination from Shadow/Seq bits in the 
Control Register drop-down menu.  

2. Select the final channel in the sequence.  

3. Click  Sample, once the control register configuration is set.  

When the evaluation board is finished taking samples on the 
selected channels in the sequence, the resulting FFTs are 
displayed in the bottom section of the main dialog box. The 
SNR:, THD:, and FREQ: results correspond to the final channel 
in the programmed sequence. 

If individual SNR:, THD: and FREQ: results are required from 
each individual channel, operate the device in normal mode 
with the sequence and shadow (Shadow/Seq) bits set to 00 and 
select the individual channel in the Control Register. 

Histogram Mode 

When operating the evaluation board in histogram mode with 
the sequence and shadow bits set to 11 in the Control Register, 
follow these steps: 

1. Select the 11 combination for Shadow/Seq in the Control 
Register drop-down menu.  

2. Select the final channel in the sequence.  

3. Select Sample once the Control Register configuration is set.  

When the evaluation board is finished taking samples on the 
selected channels in the sequence, the resulting histogram 
displays in the third portion of the Main Screen. The histogram 
corresponds to the first channel in the programmed sequence. 
The Max Code:, Min Code:, Spread:, Std Dev:, and Mean: 
results correspond to the first channel in the programmed 
sequence. 

If you would like the codes, such as the Max Code: and Min 
Code:, to correspond to a particular channel, operate the ADC 
in normal mode with the sequence and shadow (Shadow/Seq) 
bits set to 00, and select the individual channel in the Control 
Register drop-down menu. 
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EVALUATION BOARD SCHEMATICS AND ARTWORK 

06215-006

 
Figure 6. Schematic 1 
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06215-007

 
Figure 7. Schematic 2 
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Figure 8. Component Side Artwork 
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Figure 9. Solder Side Artwork 
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Figure 10. Component Placement Drawing 
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ORDERING INFORMATION 
Table 6. Bill of Materials 
Qty. Reference Designator Part Type Order Number1 
1 U1 AD7924, AD7914, AD7904 AD7924, AD7914, AD7904 
1 U2 AD713 AD713 
1 U3 REF192 REF192 
3 U4, U5, U8 AD712 AD712 
1 U6 DM74LS04N FEC 685-914 
1 U7 AD780 AD780 
6 R1 to R6 51r resistor FEC 321-7905 
10 R7 to R17 1 kΩ resistor FEC 911-859 
2 R18 3 kΩ resistor FEC 321-8119 
19 C1 to C11, C12, C14, C19, C21, C23, C25 to C27 0.1 μF capacitor FEC 499-687 
18 C15 to C18, C20, C22, C24, C28, C29, C35 to C43 10 μF capacitor FEC 197-427 
1 C13 1 μF capacitor FEC 317-640 
4 C30 to C33 68 pF capacitor FEC 722-066 
1 C34 10 nF capacitor FEC 499-225 
2 D1, D2 SD103C  
13 DIN, CS, DOUT, J4, J6, J7, J8, REFIN, SCLK, VIN0 to VIN3 50 Ω gold plated PCB SMB jack FEC 310-682 
1 J1 CON\41612\96 FEC 104-986 
1 J2 3-pin power connector FEC 151-786 
2  J3, J5  2-pin power connector FEC 151-785 
11 LK1 to LK11 2x2 way jumper FEC 511-791  
2 LK12, LK13 2x3 way jumper FEC 511-780 
1 LK14 Jumper FEC 511-705 
6 LK15 to LK20 Jumper FEC 511-705 
14 LK1 to LK14 Shorting links FEC 528-456 
5 T1 to T5 Testpoint FEC 240-333 
1  U1 SOCKET CLAMP-SOIC-TSSOP  
4 Each corner Stick-on feet FEC 651-813 
1  EVAL-AD7924/AD7914/AD7904 PCB EVAL-AD7924/ AD7914/ AD7904 
1 FEC = Farnell Electronic Components®. 

ORDERING GUIDE 
Model Description 
EVAL-AD79X4CB Evaluation Board for the AD7904/14/24 

 

ESD CAUTION 
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NOTES 
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